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Overview	
This document is meant to be used as an “as needed” job aid, for online course development. It 
can either be used to build a new course from scratch, or as a troubleshooting guide for how to 
fix issues once you have identified them.  

This job aid should be reviewed by instructional designers for DOIU annually, as part of their 
personal edification. The document itself should be reviewed for accuracy, and updated as 508 
rules are updated, and as the Lectora software is updated (at a minimum annually). 

Section 508 of the Rehabilitation Act of 1973 was refreshed January 2017, with total federal 
compliance due date of January 18, 2018. This was the first update in several years, and aligns 
to current technology, and WCAG 2.0 standards. Here is a quick reference document on the 
refresh: https://section508.gov/refresh-toolkit/revised-508-standards-quick-reference-guide 

Supporting Word documents: (Path: P:\Libraries\DOI University\508 Compliance Materials) 

• 508Proposal 
• Needs Assessment 2018 
• FinalInternshipPaperCMoore 
• DOIU Accessibility Test Plan 

 	

https://section508.gov/refresh-toolkit/revised-508-standards-quick-reference-guide
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Lectora	Job	Aid	
Use the following tables to assist in developing accessible and usable Lectora online courses. 

 

Topic: Title Options 
Selecting	Title	Options		  
 

In order to edit or review your title, select the course title, and then in the “Design” tab, click the 
“Title Options” icon. 
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Use	Web	Accessibility	Settings		  
 

Under Title Options, be sure that the “Use Web Accessibility Settings” option is checked. This 
will disable certain features that are inaccessible. Lectora® will publish ALT tags based on the 
image name, disable skins, disable rollover video controllers, set the reading order to be 
correct, and specify the language property for text blocks. 
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Topic: Keyboard Shortcuts   
How	to	assign	keyboard	shortcuts	for	learners	to	navigate	your	course		  
 

It’s important to consider learners with physical limitations, when designing the navigation in 
your course. Rather than forcing your learners to click next or back, allow them to use the 
keyboard arrows to navigate your course.  

Here’s how to assign an “OnLeftArrowGoToNextPage” action:  

• Highlight your course name (the blue book icon) 
• In the “Insert” tab, click the “Action” icon (it looks like a movie action marker) 

  
WCAG: 2.1.3 Keyboard (No Exception): All functionality of the content is operable through a 
keyboard interface without requiring specific timings for individual keystrokes. (Level AAA) 
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How	to	assign	keyboard	shortcuts	for	learners	to	navigate	your	course	(Continued)	  
 

• Select the Keystroke icon.  
• Place your cursor in the “Key” field and press the key you want to assign to the action. 

The example highlighted below is the left arrow.  
• Select “Go To”  
• Under the “Target” field, choose “Last Visited Page” 
• In the “Name” field, rename the action. The default name will be generic and confusing. 

Label this specific action “OnLeftArrowGoToLastVisitedPage” 
• Note: Many developers will also include a page that lists out each keyboard shortcut for 

disabled learners.  
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Topic: Skip Navigation 
Creating	a	Skip	Navigation	button		  
 

All courses need to be set up so that learners that use screen reading devices (such as Jaws) 
can skip the repetitive elements on each page. By making a transparent button that skips to a 
hidden element on each page, assistive devices will be able to get straight to the content, rather 
than listening to each element on the page repeated to them. 

Here’s how to set up a “Skip Navigation” button: 

• Select your last keyboard action 
• On the “Insert” tab, click the “Button” icon, and choose “Transparent” 
• Place the button in the upper left corner of the page 
• In the “Title Explorer” name the button “Skip Navigation” 
• You will update the action in a moment, after you set up the hidden target (next table). 

 
508: (o) A method shall be provided that permits users to skip repetitive navigation links.  

WCAG: 2.4 Provide ways to help users navigate, find content, and determine where they are. 
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Creating	the	Hidden	Target		  
 

Now you’ll create an invisible target for the “Skip Navigation” button you just made. (This 
assumes you’ve built your navigation buttons and GUI for the course already, as this checker 
document only describes the process of providing guidance on accessibility.) 

Here’s how to set up a “HiddenTarget” text block: 

• Select you last button, in this case it’s the “Menu” button 
• On the “Insert” tab, click the “Text Block” icon 
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Creating	the	Hidden	Target	(Continued •   )   
 

• Type a period “.” in the box and make the color match your background. In this case I 
made it white to match this GUI. 

• Resize the box and place it anywhere on the screen. In this case I put it in the upper 
right corner 

• Name the text box “HiddenTarget” 
• Double check that the “HiddenTarget” text box is in the last position before the 

Assignable Unit icon 
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Linking	the	Skip	Navigation	to	the	Hidden	Target	  
 

• Double click the action icon under your Skip Navigation button in the title explorer 
• Update your action to match the screen shot below: “Go To” “Current Page” “Scroll To: 

HiddenTarget” 
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Topic: Font treatments 
Font	Size	and	Family		  
 

Serif fonts are best used as headlines for eLearning, or in use for printed material. Sans Serif 
fonts (Arial, Verdana, Helvetica) are the preferred fonts for eLearning in general, as they are 
easier to read on a backlit screen.  

For regular body copy, do not go below 11pt for the font size. 

All text needs to remain as such, and not be made into an image. When you allow the learner to 
change the font or increase the point size, it allows for people with low vision to access your 
materials. 

WCAG: 1.4.4 Resize text: Except for captions and images of text, text can be resized without 
assistive technology up to 200 percent without loss of content or functionality. (Level AA) 

 

Special	Effects	Applied	to	Fonts	  
 

Do not apply effects to the text in your course. If you add an effect (such as a drop shadow) to 
your text, Lectora® will render it as an image, and it will become unreadable and unalterable by 
assistive technology. 

WCAG: 1.4.5 Images of Text: If the technologies being used can achieve the visual 
presentation, text is used to convey information rather than images of text except for the 
following: (Level AA) 

 

Best	Practices	Font	Formatting	  
 

• Use paragraph spacing to adjust the space between lines and between paragraphs 
(rather than extra paragraph returns). Screen readers will read aloud each extra 
paragraph return if present. 

 
• Use the bullet format for lists (rather than manual formatting). Screen readers will 

indicate a list is about to be read when properly formatted. 



DOIU Accessibility and Usability Checker 

13 

• Use a tab or manually position the text box (rather than extra spaces for alignment) 
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Topic: Color and Contrast 
Indicators	Need	to	be	More	Than	Color	Alone		  
 

The lesson should never be color dependent. Do not indicate an action to take by mention of 
color alone. For example: You should never say something like, “The red text above has been 
removed from the policy” or, “Click the green button when ready to proceed.” Rather, you would 
say, “The following text has been removed from the policy” or “Click the next button when ready 
to proceed.” 

508: (c) Web pages shall be designed so that all information conveyed with color is also 
available without color, for example from context or markup. 
WCAG: 1.4 Make it easier for users to see and hear content including separating foreground 
from background. 

 

Good	Contrast	in	Text	Treatment	for	Readability	  
 

In order to make your course readable, you need to provide good contrast, especially in regards 
to your text treatment. Here you can see a good example of high contrast, and an example of 
very poor contrast. The very best contrast is black text on a white background. There are many 
contrast calculators online if you are in doubt (such as https://contrastchecker.com/). Please 
also see the contrast checking plan as outlined in the testing document. 

    
 

WCAG: The visual presentation of text and images of text has a contrast ratio of at least 7:1, 
except for the following: (Level AAA) 

• Large Text: Large-scale text and images of large-scale text have a contrast ratio of at 
least 4.5:1; 

• Incidental: Text or images of text that are part of an inactive user interface component, 
that are pure decoration, that are not visible to anyone, or that are part of a picture that 
contains significant other visual content, have no contrast requirement. 

• Logotypes: Text that is part of a logo or brand name has no minimum contrast 
requirement. 

 

  

https://contrastchecker.com/
https://www.w3.org/TR/WCAG20/#textdef
https://www.w3.org/TR/WCAG20/#images-of-textdef
https://www.w3.org/TR/WCAG20/#contrast-ratiodef
https://www.w3.org/TR/WCAG20/#larger-scaledef
https://www.w3.org/TR/WCAG20/#user-interface-componentdef
https://www.w3.org/TR/WCAG20/#puredecdef
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Topic: Visual Elements  
Use	Empty	Alt	Tags	for	Decorative	Elements		  
 

Images that are purely decorative in nature (such as backgrounds, or decorative images that do 
not assist in the learning) should be marked with the “empty alt” marker as seen here. 

Checking the “Empty ALT Tag” box, will 
ensure that it is not read aloud to those with 
assistive devices. 

WebAim: Decoration, Formatting, Invisible: If non-text content is pure decoration, is used only 
for visual formatting, or is not presented to users, then it is implemented in a way that it can be 
ignored by assistive technology. 
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Image,	Video,	and	Audio	Naming	  
 

Images, Video, and Audio all need to be named in a descriptive and meaningful manner in the 
Title Explorer. The name is read aloud by assistive technology. Naming an image “traffic photo,” 
for example, is much easier to understand than “img_4225” is. You can change the name in 
either the Title Explorer, or in the image properties field. The name should be short and 
descriptive. 

 
508: (a) A text equivalent for every non-text element shall be provided (e.g., via “alt”, “longdesc”, or 
in element content). 

WebAim: All images, form image buttons, and image map hot spots have appropriate, equivalent 
alternative text. 

 

Flickering	or	Flashing	Elements	  
 

Do not include any elements that flicker or flash. This can cause seizures in some people. 

508: (j) Pages shall be designed to avoid causing the screen to flicker with a frequency greater than 
2 Hz and lower than 55 Hz. 

WCAG: 2.3 Do not design content in a way that is known to cause seizures. 
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Long	Descriptions	  
 

If there is no caption below an image, if the caption does not summarize the image successfully 
(such as a simple photo credit), or if a more robust explanation for the image is necessary for 
learning comprehension (as in the case of infographics or charts) provide a link to “Image 
Details” below the image.  

• Insert a text box, and type: Image Details 
• Select the text and right click it 
• Select “Add Hyperlink” in the popup window  
• Select “Display Message” on the left side 
• Type in the description for the image in the “Message” field. If it hasn’t been given to you 

by the SME, then it’s up to you to properly convey the meaning of the image. 
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Page,	Chapter,	and	Section	Naming	  
 

The default naming (Page 1, Chapter 1) is not descriptive enough. Rename the pages and 
sections of your course to reflect what is being taught on each page/section. This is also good 
practice for people without disability, as the naming will appear if you use a breadcrumb in your 
course. 

 
WCAG: 2.4.2 Page Titled: Web pages have titles that describe topic or purpose. (Level A) 
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Use	Breadcrumbs	  
 

A breadcrumb is a way to display to the learner where they are in the course (Lesson, topic and 
page name). This is populated by referencing the descriptive page names you give your course. 
Here are the steps on how to make a breadcrumb (a functioning breadcrumb is made for you in 
the Lectora accessibility template that I created). 

• At the top level of your document, insert a text box, choose the font, size and color you 
want for your breadcrumb 

• In the Title Explorer, label the textbox “Breadcrumb” 

 
• Add an action: Page Show, Change Contents, Target Breadcrumb, Value: Set Text, 

Text: VAR(CurrentChapterName) > VAR(CurrentSectionName) > 
VAR(CurrentPageName) 
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WCAG: 2.4.8 Location: Information about the user's location within a set of Web pages is 
available. (Level AAA) 
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Use	Breadcrumbs	(continued)	  
 

• Add an action: Page Show, Change Contents, Target Breadcrumb, Value: Set Text, 
Text: VAR(CurrentChapterName) > VAR(CurrentSectionName) > 
VAR(CurrentPageName) 

• Please note, I have left the more complicated 4 step breadcrumb in the template 
document, as that was the previous method used for course development for DOIU. This 
tutorial is for a simpler method of creating a breadcrumb, with only one action. 
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Hyperlink	Naming		  
 

Be descriptive in your hyperlink naming. You should never use the exact web address, rather 
describe where you are sending the learner as it’s important to let the learner know where the 
link is taking them. All links should open in a new window, so that the learner can navigate back 
to the course easily. 

 
WCAG: 2.4.4 Link Purpose (In Context): The purpose of each link can be determined from the 
link text alone or from the link text together with its programmatically determined link context, 
except where the purpose of the link would be ambiguous to users in general. (Level A) 
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Topic: Reading Order 
How	to	check	your	reading	order	  
 

The best way to check your reading order, is to print your document in outline view. The first 
elements on a page will always be the inherited items, then the chapter, then section, then the 
page. The reading order is opposite of the stacking or layering order, in that the page is read 
top down, as you would read in a book. The example below shows the correct reading order for 
a simple page. After the prompts, course title, and subtitle are read, the next element is the 
main text frame, and finally the caption under the photo. 

 
WCAG: 2.1.1 Keyboard: All functionality of the content is operable through a keyboard interface 
without requiring specific timings for individual keystrokes, except where the underlying function 
requires input that depends on the path of the user's movement and not just the endpoints. 
(Level A) 
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Topic: Audio and Video  
Synched	Closed	Captions		  
 

All audio and videos need to have synchronized closed captions. To add closed captioning: 

• Select the “Add Captions” button on the Video or Audio properties ribbon. 
• You can import an existing Web VTT, SRT, or XML file, or open a sample of each file 

type to get started. The sample file can then be modified with the correct details for your 
media. 

• Save and import the modified file to use with the video or audio. 

If an outside vendor is supplying the video, they will need to have captions already added to it. 

508: (b) Equivalent alternatives for any multimedia presentation shall be synchronized with the 
presentation. 

WCAG: 1.2.2 Captions (Prerecorded): Captions are provided for all prerecorded audio content 
in synchronized media, except when the media is a media alternative for text and is clearly 
labeled as such. (Level A) 

 

Adjusting	Volume,	Muting	and	Pausing	  
 

Adding audio to your Lectora file can be a simple process, but making auto play audio 
adjustable across your course is difficult, and requires advanced programming. Generally, we 
do not budget for narration, so this is not often an issue for us. As a rule, if you are going to 
provide audio (whether with video or not), the learner must be allowed to adjust the volume, to 
pause, and to mute it and still receive the same level of education from each page. Here is a 
link to a troubleshooting board on Trivantis which discusses how to program for the course to 
remember the user’s choice on each slide. http://community.trivantis.com/forums/topic/skins-
and-muteunmute-audio/ 

WCAG: 1.4.2 Audio Control: If any audio on a Web page plays automatically for more than 3 
seconds, either a mechanism is available to pause or stop the audio, or a mechanism is 
available to control audio volume independently from the overall system volume level. (Level A) 

 

Text	Equivalent	  
 

If you have a video, you need to have a text equivalent of what the video is demonstrating. For 
example: if you had a video of a person cleaning beakers in a laboratory, you would have a text 
box describing what the person is doing in a small font that matches the background that is 
hidden behind the video. That way a person with an assistive device, such as Jaws, would be 
able to “read” the video’s description, but it would not appear to a sighted user. 

This is related to closed captions, but rather than just writing the spoken track, it’s important to 
provide context of what actions are taking place on screen. Here is a link demonstrating what 
it’s like to view The Lion King with descriptions for the non-sighted. 
https://www.youtube.com/watch?v=jT5AsjzgIC4 

WCAG: 1.2.3 Audio Description or Media Alternative (Prerecorded): An alternative for time-
based media or audio description of the prerecorded video content is provided for synchronized 
media, except when the media is a media alternative for text and is clearly labeled as such. 
(Level A) 

http://community.trivantis.com/forums/topic/skins-and-muteunmute-audio/
http://community.trivantis.com/forums/topic/skins-and-muteunmute-audio/
https://www.youtube.com/watch?v=jT5AsjzgIC4
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Topic: Games 
Lectora’s	Flash	Games	are	inaccessible		  
 

In general, do not use the games, as they are inaccessible. 

 

Topic: Tests 
Inaccessible	tests		  
 

Drag and drop, matching, and hot spot questions are inaccessible to users with physical and 
sight disabilities. If you want to keep one of these question types, you must provide an alternate 
question for those with disabilities. This is a fairly detailed/advanced process which is described 
in this youtube video at the 28 minute mark. 

508: (n) When electronic forms are designed to be completed online, the form shall allow 
people using assistive technology to access the information, field elements, and functionality 
required for completion and submission of the form, including all directions and cues. 

WCAG: 2.4 Provide ways to help users navigate, find content, and determine where they are. 

 

Accessible	tests		  
 

All other Lectora question formats are accessible without any modification: Multiple choice, 
true/false, Multiple answer, short answer, essay, fill in the blank, number entry, Likert, and 
Rank/Sequence. 

 
Timed	tests	  
 

Do not include timed tests in any course for DOIU. They are inaccessible for those with physical 
limitations. If timed tests are included, you will need to provide a way for the learner to select 
additional time and with ample warning. 

508: (p) When a timed response is required, the user shall be alerted and given sufficient time 
to indicate more time is required.  

WCAG: 2.2 Provide users enough time to read and use content.  

 
 

  

https://www.youtube.com/watch?v=XrtdlwhY0bk&t=839s&list=PLmpj_4YzBpBdKEh_aqxw1zy68rMZFcCB3&index=10


DOIU Accessibility and Usability Checker 

26 

Topic: Tables 
Header	Rows		  
 

Table header rows must be specified. Lectora supports tables with one header row. In order to 
ensure that the header data is included: 

• Select all of the cells of the table, and click the “Include Header” check box in the upper 
left corner of the TABLE tab 

 
508: (g) Row and column headers shall be identified for data tables. 

WCAG: 2.4.4 Link Purpose (In Context): The purpose of each link can be determined from the 
link text alone or from the link text together with its programmatically determined link context, 
except where the purpose of the link would be ambiguous to users in general. (Level A) 

WebAim: The purpose of each link (or form image button or image map hotspot) can be 
determined from the link text alone, or from the link text and its context (e.g., surrounding 
paragraph, list item, table cell, or table headers). 
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Topic: Checking for 508 Compliance  
508	Compliance	Checker	  
 

Select the “Tools” tab, select the “508 Compliance Check” icon. This will check your course for 
compliance issues. If you run this function from the beginning, it will not let you add inaccessible 
functions to your course. While it can find several issues, it is not comprehensive enough to use 
as a standalone checker. Refer to the DOI Accessibility Test Plan additionally.  
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Topic: Table of Contents (TOC)  
Accessible	Table	of	Contents	  
 

One of the functions that is present in all of our courses is to include a table of contents page 
which links to a “Menu” button. In order to make your TOC accessible, select the “Indented List” 
layout, and uncheck the “Use Icons” box. 

 
 

Topic:  
Page		  
 

Xx 

 

 


	OLE_LINK9
	OLE_LINK144
	OLE_LINK117

